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ABSTRACT  

 

Imipress Tablet 25 mg is one of the products of Chemical Company of Malaysia, 

Duopharma Sdn. Bhd, CCMD. The Active Pharmaceutical Ingredient is Imipramine 

Hydrochloride which contains 25 mg per tablet. Method validation was carried out in terms 

of specificity (force degradation), placebo analysis, linearity and range, accuracy, precision 

(repeatability and intermediate precision), robustness and solution stability. This method 

has been shown to be linear, accurate, precise, rugged and robust. The HPLC method is 

suitable for use as a stability indicating method for determination of Imipramine 

Hydrochloride content in Imipress Tablet 2 mg. Good linearity was established with R
2
 of 

1.000 with the mean accuracy of 99.83%. All the RSD (%) were less than 2% and 1% 

for %RSD of standard peak area and %RSD of retention time, respectively. The analytical 

method developed and validated for assay by HPLC is suitable for the accurate and precise 

determination of Imipramine Hydrochloride content in Imipress Tablet 2 mg.   
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ABSTRAK 

 

 

Imipress Tablet 25 mg adalah salah satu produk Chemical Company of Malaysia, 

Duopharma Sdn. Bhd, CCMD. Ramuan Farmaseutikal Aktif Imipramine Hidroklorida 

mengandungi 25 mg untuk sebiji pil. Pengesahan kaedah telah dijalankan dari segi 

kekhususan (memaksa degradasi), analisis plasebo, kelinearan dan pelbagai, ketepatan 

(kebolehulangan dan ketepatan perantaraan), kemantapan dan kestabilan penyelesaian. 

Kaedah ini telah terbukti linear, tepat, tahan lasak dan teguh. Kaedah HPLC adalah sesuai 

untuk digunakan sebagai kestabilan kaedah yang menunjukkan untuk penentuan kandungan 

Imipramine Hidroklorida dalam Imipress Tablet 2 mg. Kelinearan baik telah ditubuhkan 

dengan R
2
 1.000 dengan ketepatan purata sebanyak 99.83%. Semua sisihan piawai relatif 

(%) adalah kurang daripada 2% dan 1% untuk% sisihan piawai relatif luas permukaan 

untuk standard dan% sisihan piawai relatif untuk retention time. Kaedah analisis yang 

dibangunkan dan disahkan untuk cerakin oleh HPLC sesuai untuk penentuan secara tepat 

dan tepat kandungan Imipramine Hidroklorida dalam Imipress Tablet 2 mg. 
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CHAPTER 1 

 

INTRODUCTION 

 

1.1 Background of Study and Statement of Problem 

 

1.1.1 Analytical Method Validation in Pharmaceutical Industry 

Analytical method validation is just one type of validation required during drug 

development and manufacturing. To comply with the requirement of current GMP, 

pharmaceutical companies should have an overall validation policy which 

documents how validation will be performed. This will include the validation of 

production processes, cleaning procedures, analytical method, in process control test 

procedure and computerized system. The purpose of this validation is to show that 

processes involved in the development and manufacturer of drugs, such as 

production, cleaning and analytical testing can be performed an effective and 

reproducibility manner.
[7]

 

 

The reason that validation is included in cGMP in this way is to ensure that 

quality is built in at every step and not just tested for at the end. Validation is 

intended to provide assurance of the quality for the design, manufacturer and use of 

the system or process that cannot be found by simple testing alone.
[7]  
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Once a method has been develop and validated it may be used for routine analysis 

as shown in Figure 1. However, changes may occur which make it necessary to 

evaluate whether the method is still suitable for its intended use. The change may be 

covered may result in revalidation and in some cases, redevelopment of the method 

followed by validation of the new method. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: The cycle of analytical method validation 
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1.1.2 Active Pharmaceutical Ingredient: Imipramine Hydrochloride 

Imipress Tablet 25 mg is one of the products of Chemical Company of 

Malaysia, Duopharma Sdn. Bhd, CCMD. The API is Imipramine 

Hydrochloride, IH, which contain 25 mg per tablet. The total weight of one 

individual Imipress Tablet 25 mg is 140 mg, which contain 115 mg of 

placebo. The placebo (also known as excipient) consist of Magnesium 

Stearate (2.1 mg), Lactose (98.578 mg), Aerocil (0.28 mg), Corn Starch (7 

mg), Polyvinylpyrrolidone (2.8 mg), Carmoisine (0.042 mg) and Promigel 

(4.2 mg).  

 

IH is a tricyclic antidepressant of the dibenzazepine group. IH also 

known as Tofranil as the trade name. 
[11]

 The molecular structure and the 

characteristic of IH had shown in Figure 2 and Table 1, respectively.  

 

 

Figure 2: Imipramine Hydrochloride 
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Systematic 

IUPAC name 

3-(10,11-dihydro-5H-dibenzo[b,f]azepin-5-yl)-N,N-

dimethylpropan-1-amine 

Formula C19H25CIN2 

Molar Mass 316.5 g/mol 

Characters A white or slightly yellow and crystalline powder 

Solubility Freely soluble in water and in alcohol 

 

 Table 1: Imipramine Hydrochloride 

 

The metabolism of IH within the body, it is converted to desipramine which 

belong to another type of Tricyclic antidepressant.
[13] 

The side effects of IH 

include the central nervous system such as dizziness, drowsiness, headache, 

weakness, insomnia, nightmares and increase psychiatric symptoms. For 

gastrointestinal, the patient will have for dry mouth, nausea, vomiting, 

increase appetite, cramps, jaundice and taste change. Moreover, the 

symptoms and the treatment of an Imipramine overdose are largely the same 

for the other tricyclic antidepressants. Cardinal symptoms are cardiac and 

neurological disturbances. Any ingestion by children should be considered 

as serious and potentially fatal.
[11]
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1.2 Significant of Study 

This study focuses on the extraction of the IH, determination of analytical 

characteristics method and percent assay of IH in Imipress Tablet 25 mg. The 

concerns about the percent assay of this API contain in the medicine have promoted 

for the Assay studies. The use of analytical methods during development and 

manufacturing provides information on potency which can relate directly to the 

requirements of known dose; impurities which can relate to the safety profile of the 

drug, evaluation of key drug characteristics such as crystal form, drug release, drug 

uniformity and properties which can compromise bioavailability; degradation 

products methods need to be stability indicating and effect of key manufacturing 

parameter  to ensure that the production of drug substance and drug product is 

consistent.
[8]

  

 

 The validation which is performed on the method which generate the data 

needs to demonstrate that they can do so reliability and consistently. Hence, this 

method validation is use full for routine analysis in QC and to demonstrate that the 

test method of IH in Imipress Tablet 25 mg is suitable for the intended use. 

 

1.3 Objectives of the study  

An analytical method details the steps necessary to perform an analysis. This may 

include preparation of samples, standards and reagents, use of apparatus, generation 

of the calibration curve, use of the formula for calculation.
[8] 

The intention of this 

study is to validate the assay test method by high performance liquid 

chromatographic analytical method in quantitating IH in Imipress Tablet 25 mg. 
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CHAPTER 2 

  

LITERATURE REVIEW 

 

2.1  Functionality of Imipramine Hydrochloride  

The primary function of IH is to treatment of mental depressive disorder, MDD is a 

mental disorder characterized by a pervasive and persistent low mood that is 

accompanied by low self-esteem and by a loss of interest or pleasure in normally 

enjoyable activities. MDD is a disabling condition that adversely affects a person’s 

family, work or school life, sleeping and eating habits and general health.
[9]  

 

2.2 Therapeutic Uses of Imipramine Hydrochloride 

IH also used to treatment of enuresis which refers to repeated inability to control 

urination which usually limited to describing old enough to be expected to exercise 

such control.
[10] 

IH is used in the treatment of depression such as associated with 

agitation or anxiety and has similar efficacy to the antidepressant drug 

moclobemide. 
[12]  

 

2.3 Mechanism of Action of Imipramine Hydrochloride 

IH affects numerous neurotransmitter systems known to be involved in the etiology 

of depression, anxiety, enuresis and numerous other mental and physical conditions. 

IH is similar in structure to some muscle relaxants and has a significant analgesic 

effect that is very use full in some pain conditions.
[11]
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2.4 Analytical determination of Imipramine Hydrochloride 

A variety of procedures have been developed for the analysis of IH. IH has been 

determined by a variety of analytical technique such as spectrophotometry, 

spectofluorimetry, conductimetry and flow injection methods. However, many of 

these methods are limited in their applications or rather tedious and time 

consuming.
[15] 

 

HPLC has been applied to measure small amounts of IH and its major 

metabolite, desipramine in serum. A computerized GCMS technique has also been 

proposed for quantitatively determination of IH. TLC method has been used for the 

separation and detection of IH.
[14] 

Ion-SME can be applied successfully for the 

determination of IH in substance and in pharmaceuticals. 

 

The recommended method from monograph which includes United State 

Pharmacopia, USP 36 and British Pharmacopia, BP 2013 for the quantitating 

percent assay of “Imipramine Hydrochloride Tablet” is by using UV-Vis 

Spectrophotometer. This method is simple and sensitive for the determination of IH 

in Imipress Tablet 25 mg. 

 

 

 

 

 

        

Fi 
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However, in this study, the method validation of Imipramine Hydrochloride 

in Imipress Tablet 25 mg uses an in-house method as the analytical test method. The 

method originally adopted from USP 36, Volume 2 under “Imipramine 

Hydrochloride”, page 3888 (refer to Figure which using the HPLC method. This 

method considered as in-house method because the validation of IH are base on raw 

material method rather than choosing finish product method.  

 

In CCMD, there were three different departments in laboratory side which 

include QC Department, Validation Department and Stability Department. In order 

to standardize the analytical test method for IH in Imipress Tablet 25 mg for all 

departments, only one establishes method will be chosen as the validated method.  

 

For stability department, the use of HPLC method are more recommended 

because recent days, the current guidelines and regulatory requirements are very 

stringent in terms of estimation and quantification of residual impurities in any 

synthetic route or process, due to this reason the separation of all compounds in 

single run or during analysis, LC methods was taken preference over regular 

conservative mode methods of analysis. The advantages of LC methods are that the 

developed analytical methods were posses’ greater selectivity, sensitivity, accurate, 

precise and robust. Therefore, all most all methods used in Stability Department was 

developed by using HPLC.
[15]
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2.5 Method Validation in according to ICH Guidelines 

According to International Conference on Harmonization, ICH, Guidelines, the 

discussion of the validation of analytical procedures is directed to the four most 

common types of analytical procedures which are identification test, quantitative 

tests for impurities’ content, limit tests for the control impurities and quantitative 

test of the API in samples of drug substance or drug or other selected components 

(s) in the drug product.
[2]

 The parameter to be validated for assay study will base on 

the Table 2. 
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Type of analytical 

procedure 

characteristics 

Identification Testing for 

Impurities 

(quantitative Limit) 

Assay  

(dissolution, 

content and 

potency) 

Accuracy - + - + 

Precision - + - + 

      Repeatability - + - + 

      Intermediate 

Precision 

- + 
(1)

 - + 
(1)

 

Specificity + - + + 

Detection Limit - - 
(3)

 + - 

Quantitation Limit - + - - 

Linearity - + - + 

Range - + - + 

- Signifies that this characteristics is not normally evaluated 

+  Signifies that this characteristics is normally evaluated 

(1) In cases where reproducibility has been performed, intermediate precision is not 

needed. 

(2) Lack of specificity of one analytical procedure could be compensated by other 

supporting analytical procedures 

(3) May be needed in some cases. 

 

Table 2: Type of analytical procedure characteristic 
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CHAPTER 3 

 

METHODOLOGY 

 

3.1       Chemicals and reagents 

Imipramine Hydrochloride (IH) Working Standard was an in-house working 

standard. HPLC grade methanol and HPLC grade acetonitrile were purchased from 

Merck. Triethylamine, Perchloric acid (for adjusting pH) and Sodium Perchloride 

ware purchased from Fluka. Deionized water was used throughout the study. 

 

3.2 Instrumentation and chromatographic conditions 

Quantitative analysis of IH was carried out using a HPLC unit that consisted of a 

degasser, Model: Shimadzu DGU-20A3 Degasser; pump; Model: Shimadzu LC-

20AT Prominence LC; Model: Shimadzu SIL-20A Prominence, Column oven; 

Model Shimadzu CTO – 10AS VP and computer; Model: DELL. The injection was 

done by using 20 µL by auto sampler; Model: Shimadzu SIL-20A Prominence.  

 

Separation was achieved using a 5 µm Phenomenex C18, Gemini (150 mm 

length × 4.6 mm diameter). The colum temperature was set to 40°C.  The mobile 

phase was 0.06 M Sodium Perchlorate: Acetonitrile: Triethylamine (625:375:1) 

with adjustment the pH 2.0 with Perchloric Acid and the flow rate was 1.0 mL 

minˉ
1
. The detector was set at 269 nm. 
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3.3 Apparatus 

The apparatus used in this study were 25 mL, 50 mL, 100 mL, 200 mL and 1000 mL 

volumetric flasks; 5 mL, 6 mL, 10 mL, 15 mL pipettes; sonicator; water bath and 

beaker.  

 

3.4 Preparation of 0.06M Sodium Perchlorate 

Sodium perchorate about 7.34.64 g weight was transferred into 1000 mL volumetric 

flask. All chemical was dissolved and diluted with water and it will mix well. Mass 

was calculated using following calculation:  

 

Mole = Molarity × Volume (L) 

= 0.06 M × 1 L 

= 0.06 mole 

 

Mass  = Mole × Molecular weight 

= 0.06 mole × 136.086 g/mole 

= 3.402 g 

 

3.5 Preparation of diluent  

The diluent was water and acetonitrile with the ratio 5:3. The use of the diluent is 

for dilution. 
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3.6 Preparation of standard (Imipramine Hydrochloride Working Standard) 

30 mg of IH working standard was transferred into 100 mL volumetric flask and top 

up to volume using diluent. Then, label the solution as a Standard Solution. The 

Standard Solution contains approximately 0.3 mg/mL of IH. This Standard 

Solution was filtered through a 0.45 µm membrane filter and inject into the HPLC 

system for analysis. 

 

3.7 Preparation of sample (Imipress Tablet 25 mg) 

20 tables of Imipress Tablet 25 mg is weigh to get the average weight of this tablet. 

Grind the tablet sample into fine powder. Transfer about 168 mg (equivalent to 30 

mg of IH) of sample into a 100 mL volumetric flask. Dilute to volume with diluent, 

mix well and label it as Sample Solution. The Sample Solution contains 

approximately 0.3 mg/mL of IH. Sample Solution is filter through a 0.45µm 

membrane filter and inject once into the HPLC system for analysis. Six replicate of 

sample preparation will be performing. 
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3.8 Method Validation Procedure 

3.8.1 System Suitability  

The Standard Solution from Section  3.6 is use for the system suitability. 

The system suitability requirements for the above assay chromatographic 

procedure are shown in Table 3: 

 

Parameters  Criteria 

Tailing Factor < 2 

System precision 

i) % RSD of Standard retention time ≤ 1% 

ii) % RSD of Standard peak area ≤ 2% 

Theoretical Plate Count >2000 

 

Table 3: Parameter for system suitability 

 

3.8.2 Placebo analysis  

The placebo is prepared by mixing all the excipients and kept in an amber 

glass bottle. This placebo is a combination of all excipients for Imipress 

Tablet 25 mg as shown in Table 4. For the procedure, transfer about 138 mg 

of Placebo into a 100 mL volumetric flask, dilute to volume with diluent and 

mix well. Label this as Placebo Solution. The Placebo Solution contains 

approximately 1.38 mg/mL of Placebo. Placebo Solution is filter through a 

0.45µm membrane filter and inject into the HPLC system for analysis. One 

(1) Imipress Tablet 25 mg contains 115 mg of placebo and 25 mg of IH. For 

assay sample preparation, the sample solution contains 0.3 mg/mL of IH and 

1.38 mg/mL of placebo. 
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No Excipients Excipients (mg) (w/w) (w/w)% 

Quantity of 300 

tablets (mg) 

1 Magnesium Stearate 2.1 0.0182 1.82 5.46 

2 Aerosil 0.28 0.0024 0.24 0.72 

3 Cornstarch 7 0.0608 6.08 18.24 

4 Lactose 98.578 0.8572 85.72 257.16 

5 Polyvinylpyrrolidone 2.8 0.0243 2.43 7.29 

6 Carmoisine 0.042 0.0003 0.03 0.09 

7 Promigel 4.2 0.0365 3.65 10.95 

Total 115 0.9997 99.97 299.91 

 

Table 4: Placebo for Imipress Tablet 25 mg 

 

 

 

 

 

 

 

 

 

 

 

 



16 

 

3.8.3 Specificity (Forced Degradation) 

Forced degradation has been carried out by introducing chemical degradant 

into sample in three different routes. 

      

3.8.3.1 Control 

420 mg of powdered tablets was weight (equivalent to 75 mg of IH) and 

transferred into 50 mL volumetric flask, dissolved and diluted to volume 

with diluent. This solution was heated in water bath at 70°C for 2 hours. 

This solution was labeled as Sample Solution (a1). 5 mL of Sample 

Solution (a1) was pipette into 25 mL volumetric flask and top up to volume 

with diluent. The solution was labeled as Sample Solution (a2). This 

solution contains approximately 0.3 mg/mL of IH and 1.38 mg/mL of 

Placebo and injected with 20 µL of the resulting solution in the HPLC 

system. 

 

3.8.3.2 Acid hydrolysis 

420 mg of powdered tablets was weight (equivalent to 75 mg of IH) and 

transferred into 50 mL volumetric flask, dissolved and diluted to volume 

with 3M HCl. This solution was heated in water bath at 70°C for 2 hours. 

This solution was labeled as Sample Solution (b1). 5 mL of Sample 

Solution (b1) was pipette into 25 mL volumetric flask. For neutralization, 

add 5 mL of 3M NaOH and top up to volume with diluent. This solution was 

labeled as Sample Solution (b2). This solution contains approximately 0.3 

mg/mL of IH and 1.38 mg/mL of Placebo and injected with 20 µL of the 

resulting solution in the HPLC system. 
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3.8.3.3 Base hydrolysis 

420 mg of powdered tablets was weight (equivalent to 75 mg of IH) and 

transferred into 50 mL volumetric flask, dissolved and diluted to volume 

with 3M NaOH. This solution was heated in water bath at 70°C for 2 hours. 

This solution was labeled as Sample Solution (c1). 5 mL of Sample 

Solution (c1) was pipette into 25 mL volumetric flask. For neutralization, 

add 5 mL of 3M HCl and top up to volume with diluent. This solution was 

labeled as Sample Solution (c2). This solution contains approximately 0.3 

mg/mL of IH and 1.38 mg/mL of Placebo and injected with 20 µL of the 

resulting solution in the HPLC system. 

 

3.8.3.4 Oxidation degradation 

420 mg of powdered tablets was weight (equivalent to 75 mg of IH) and 

transferred into 50 mL was heated in water bath at 70°C for 2 hours This 

solution was labeled as Sample Solution (d1). 5 mL of Sample Solution 

(d1) was pipette into 25 mL volumetric flask and top up to volume with 

diluent. Label this as Sample Solution (d2). This solution contains 

approximately 0.3 mg/mL of IH and 1.38 mg/mL of Placebo and injected 

with 20 µL of the resulting solution in the HPLC system. 

 

The acceptance criteria that need to full fill were listed below: 

a) Analyte peak is well resolved from the other peaks, resolution > 1.5 

b) Analyte peak degraded at least 20% by one of the degradation method 

c) Peak purity index > 0.95 
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3.8.4 Linearity and Range 

Standard Stock Solution was prepared by dissolving approximately 300 

mg of Imipramine Hydrochloride in 200 mL volumetric flask with diluent 

(concentration is 1.5 mg/mL of Imipramine Hydrochloride). From this 

Standard Stock Solution, a series of five standards that span a range of 50-

150% were prepared. 

 

For 50% (0.15 mg/mL of Imipramine Hydrochloride), 5 mL of 

Standard Stock Solution was pipette into 50 mL volumetric flask and top 

up to volume with diluent. For 80% (0.24 mg/mL of Imipramine 

Hydrochloride), 4 mL of Standard Stock Solution was pipette into 25 mL 

volumetric flask and top up to volume with diluent. For 100% (0.3 mg/mL 

of Imipramine Hydrochloride), 10 mL of Standard Stock Solution was 

pipette into 50 mL volumetric flask and top up to volume with diluent. For 

120% (0.36 mg/mL of Imipramine Hydrochloride), 6 mL of Standard 

Stock Solution was pipette into 25 mL volumetric flask and top up to 

volume with diluent. For 150% (0.45 mg/mL of Imipramine Hydrochloride), 

15 mL of Standard Stock Solution was pipette into 50 mL volumetric flask 

and top up to volume with diluent. Each solution were injected three times 

into the HPLC system and record the chromatogram of each solution, at 

50%, 80%, 100%, 120% and 150% according to the method as described in 

section 3.2.  
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The peak area ratio for each level versus concentration was plotted and 

performs a linear regression using the least square method on the resulting 

curve. The acceptance criteria that need to full fill are listed below: 

a) R
2 

> 0.999 

b) %RSD of peak response ratio ≤ 2%. 

c) Magnitude of intercept against 100% working standard + 2%. 

 

3.8.5 Accuracy 

For accuracy, Standard Stock Solution from Section 3.4.4 was used and 

placebo standard solution was prepared by dissolving 345 mg of placebo 

into 50 ml volumetric flask with diluent (concentration is 6.9 mg/mL of 

placebo). Accuracy is assessed by performing 3 separate replicate recovery 

experiments with ‘spiked standard’ at 3 levels; 50%, 100% and 150% of the 

working concentration of Imipramine Hydrochloride.  

 

10 mL of placebo was transferred into 50 mL volumetric flask; 5 mL 

of standard stock solution was spiked into the solution and top up to volume 

with diluent. This solution contains 50% of spiked Imipramine 

Hydrochloride (0.15 mg/mL of Imipramine Hydrochloride and 1.38 mg/mL 

of placebo). 

 

10 mL of placebo was transferred into 50 mL volumetric flask; 10 

mL of standard stock solution was spiked into the solution and top up to 

volume with diluent. This solution contains 100% of spiked Imipramine 
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Hydrochloride (0.3 mg/mL of Imipramine Hydrochloride and 1.38 mg/mL 

of placebo). 

 

10 mL of placebo was transferred into 50 mL volumetric flask; 15 

mL of standard stock solution was spiked into the solution and top up to 

volume with diluent. This solution contains 150% of spiked Imipramine 

Hydrochloride (0.45 mg/mL of Imipramine Hydrochloride and 1.38 mg/mL 

of placebo). Each spiked sample was injected once into the HPLC system. 

For each sample, the sample concentration for Imipramine Hydrochloride 

using standards prepared was calculated. The percent recovery from the 

sample at each level was computed. The acceptance criteria that need to full 

fill were listed below: 

 

a) Overall mean accuracy within 100% ± 2% 

b) Overall %RSD for the measurement precision < 2% 

c) Confidence limits at 95%, µ is 100%  ±2% 

 

3.8.6 Precision  

3.8.6.1 Repeatability  

For repeatability test, 6 replicates of sample according to method as 

described in section 3.7 were prepared versus a freshly prepared standard as 

described in section 3.6. The precision between individual results was 

calculated and expressed as %RSD. The acceptance criteria that need to full 

fill were listed below: 

a) %RSD of standard retention time < 1% 
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b) %RSD for standard peak area < 2% 

c) %RSD of sample result < 2% 

d) Theoretical plate count > 2000 

e) Tailing factor < 2 

 

3.8.6.2 Intermediate Precision 

Intermediate precision was carried out by different analyst on different day, 

using different HPLC instrument and also different standard and samples 

preparation. The samples were prepared in 6 replicates according to method 

described in section 3.7. The standard solution was prepared as described in 

section 3.6. The acceptance criteria that need to full fill were listed below: 

a) %RSD of standard retention time < 1% 

b) %RSD of the standard peak area < 2% 

c) %RSD of sample result < 2% 

d) Difference of mean value for results between analysts within ± 2%. 

 

3.8.7 Robustness 

For robustness test, 6 replicates of sample were prepared according to the 

method as described in section 3.7 versus a freshly standard as described in 

section 3.6. The robustness analysis was performed under different 

conditions that vary slightly from the method parameters. Six replicate 

samples were analyzed at different flow rate, pH and different ratio of 

mobile phase, refer to Table 5: 
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Condition 

Flow 

Rate 

(mL/min) 

 

 

pH 

Mobile Phase 

Remarks 0.06M 

Sodium 

Perchlorate 

Acetonitrile Trietylamine 

A 1.0 2.0 625 375 1 Original 

B 1.2 2.0 625 375 1 
Increase flow 

rate 

C 0.8 2.0 625 375 1 
Decrease flow 

rate 

D 1.0 2.0 605 395 1 

Increase 

organic 

mobile phase 

E 1.0 2.0 645 355 1 

Decrease 

organic 

mobile phase 

F 

 
1.0 2.2 625 375 1 Increase pH 

G 

 
1.0 1.8 625 375 1 Decrease pH 

 

Table 5: Parameter for Robustness 

 

The mean results for different conditions were compared against the mean 

result for the original condition. The acceptance criteria that need to full fill 

were listed below: 

 

a) System suitability for 7 conditions is met if: 

i. Tailing factor of standard solution is < 2 

ii. Theoretical plate count of 7 injections of standard solution > 2000 

iii. Precision of 6 injections of standard solution (%RSD) <2% 

b) Difference of mean values of assay results for 6 conditions compare to 

original conditions are  not more than ± 2% 

c) % RSD of standard retention time for 7 conditions are ≤ 1% 

d) % RSD of sample assay for 7 conditions are ≤ 2% 
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3.8.8 Solution Stability 

For solution stability test, 6 replicates of sample were prepared according to 

the method as described in section 3.7 versus a freshly prepared standard as 

described in section 3.6. The samples were kept in the HPLC auto sampler at 

room temperature and re-inject after 24 hours to determine whether the 

samples are stable within 24 hours. A fresh new standard solution was 

prepared and compared to the standard solution that kept for the specific 

hours at room temperature. The mean assay value for samples after 24 hours 

using new standard was compared against mean assay value for samples at 

initial injection. The acceptance criteria that need to full fill were listed 

below: 

 

a) Difference of mean values assay results ≤ 2% 

b) Difference of peak area for freshly prepared standard solution and 

standard solution kept for specific hours is between 98% to 102% 
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CHAPTER 4 

 

RESULTS AND DISCUSSIONS 

 

4.1 Method Validation for Assay Test Method 

Method Validation is the process to confirm that the analytical procedure employed 

for a specific test is suitable for its intended use
.[2]

 Methods need to be validated or 

revalidated before their introduction into routine use, whenever the conditions 

change for which the method has been validated, whenever the method is changed 

and the change is outside the original scope of the method, when quality control 

indicates an established method is changing with time and in order to demonstrate 

the equivalence between two methods. 
[3]

 

The validity of this method has been demonstrated in laboratory experiments 

using samples and standards that are similar to the samples analyzed routinely. 
[3]

 In 

this study, the method was validated in terms of system suitability, specificity force 

degradation placebo analysis, linearity and range; accuracy, intermediate precision, 

robustness and solution stability.  
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4.2 System Suitability 

In many analytical procedures, the integral part is the system suitability testing. The 

tests are based on the concept that the equipment, electronics, analytical operations 

and samples to be analyzed constitute an integral system that can be evaluated as 

such System Suitability test parameters to be established for a particular procedure 

depend on the type of procedure being validated. 
[1] 

The system suitability results 

and chromatogram of IH Working Standard in this study were showed in Table 6 

and Chromatogram 1 (Appendix 2), respectively. 

 

Parameters Acceptance Criteria Results 

Tailing Factor ≤ 2 1.6 

System precision 

i) % RSD of Standard retention time ≤ 1% 

ii) % RSD of Standard peak area ≤ 2% 

0.4 

0.0 

Theoretical Plate Count > 2000 6676.8 

 

Table 6: The system suitability results for IH Working Standard 

 

4.2.1 Placebo analysis 

Placebo also known as excipient was the inactive ingredient in drug product. The 

placebo analysis was performed in order to investigate whether the placebo peak 

will interfere with the analyte peak or not. In this study, it shows that the placebo in 

Imipress Tablet 25 mg peak not give any interference to the IH peak 

(Chromatogram 2 and 3 in Appendix 2). 
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4.2.2 Specificity (Forced Degradation) 

Forced degradation usually involved the exposure of representative samples of drug 

product to the relevant stress conditions of heat, humidity, acid or base hydrolysis 

and oxidation. These testing play an important role in the drug development process. 

The results of force degradation studies can facilitate stability indicating method 

development, drug formulation design, selection of storage conditions and 

packaging, better understanding of potential liabilities of the drug molecule 

chemistry and solving of stability related problems. 
[4]

 

 

In this study, 3M Hydrochloric Acid and 3M Sodium Hydroxide were 

represented the chemical degradant for acid hydrolysis degradation and base 

hydrolysis degradation, respectively. While, 3% Hydrogen Peroxide was the 

chemical degradant for oxidation degradation. The result for stress conditions and it 

chromatogram were show in Table 7 and Chromatogram 4 to 7 (Appendix 2), 

respectively. From acid hydrolysis degradation condition, it shows no interference 

of IH peak. The percent (%) degradation for acid hydrolysis degradation, base 

hydrolysis degradation and oxidation degradation were 31.47%, 82.43% and 

10.96%.  The % degradation was calculated using the following formula: 

 

% Degradation = 

Ranalyte in diluent (Control) – Ranalyte in degradation 

Ranalyte in diluent (Control) 

In which; 

Ranalyte  is the peak area of IH 

Diluent act as a control  

Degradation including acid and base hydrolysis and oxidation degradation 
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Peak purity index were used to detect the presence of an impurity that is co eluting 

with the analyte peak. 
[5]

 As showed in Table 8 and Figure 6 to 9 (Appendix 2), all 

of the chromatogram shows peak purity index 1.000. Method was able to separate 

IH from possible degradation peaks. The test showed that no peak overlapped with 

IH peak after degradation. 

 

Table 7: Results for stress conditions for IH in Imipress Tablet 25 mg 

Stress Condition Acceptance criteria Results 

Acidic 3M HCl / 

70ºC/ 2 hours 

i. Analyte peak is well 

resolved from the other 

peaks, resolution > 1.5 

ii. Analyte peak degraded at 

least 20% by one of the 

degradation method 

 

i. No interference of IH peak  

ii. % degradation is 31.47% 

Basic 3M NaOH / 

70ºC/ 2 hours 

i. Analyte peak is well 

resolved from the other 

peaks which has resolution 

10.99 

ii. % degradation is 82.43% 

Oxidation 3% H2O2 / 

70ºC/ 2 hours 

i. Analyte peak is well 

resolved from the other 

peaks which have 

resolution 16.39 and 1.59  

ii. % degradation is 10.96%  
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Table 8: Peak Purity for stress conditions for IH in Imipress Tablet 25 mg 

Stress Condition Acceptance criteria Peak Purity Index 

Sample in diluent (control) > 0.95 1.000 

Sample in 3M HCl / 70ºC/ 2 hours > 0.95 1.000 

Sample in 3M NaOH / 70ºC/ 2 hours > 0.95 1.000 

Sample in 3% H2O2 / 70ºC/ 2 hours > 0.95 1.000 

 

4.2.3 Linearity and Range  

A linear relationship should be evaluated across the range of the analytical 

procedure. Linearity should be evaluated by visual inspection of a plot of signals as 

a function of analyte concentration. If there is a linear relationship, test results 

should be evaluated by appropriate statistical methods. The correlation coefficient, 

y-intercept, slope of the regression line and residual sum of squares should be 

measured. For establishment of linearity, a minimum of five concentrations is 

recommended. 
[2] 

 

The specified range is normally derived from linearity studies and depends 

on the intended application of the procedure. It is established by conforming that the 

analytical procedure provides an acceptable degree of linearity, accuracy and 

precision when applied to samples containing amount of analyte within or at the 

extremes of the specified range of the analytical procedure. 
[2] 
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The calibration curve obtained was a plot of peak area (V per seconds) as a 

function of concentration (mg/mL) as shown in Figure 4. A range of IH working 

standards at concentration ranges from 50% to 150% (5 points calibration) was 

selected in order to determine limit of linearity of the method. The chromatogram of 

each concentration can be seen in Chromatogram to 8 to 12. The data obtained, the 

calibration curve and the peak response were shown in Table 9, Table 10, Figure 4 

and Figure 5. R
2
 value of 1.000 in Figure 5 proves that it is a linear calibration curve 

and this range was suitable with the purpose of this study. The %RSD for peak 

response was 0.3% which is less than 2%. The peak response and peak response 

ratio were calculated base on following formula: 

 

Peak Response = 

Peak Area of IH 

Each Concentration of IH 

 

Peak Response 

Ratio  

= 

Peak Response of each concentration of IH 

Mean peak response of IH 

 

Table 9: IH Standard Stock use in Linearity and range 

Imipramine Hydrochloride 

Weight of standard  300.63 mg 

Concentration of standard stock solution 1.50315 mg/mL 

Purity of IH  100.00% 
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Table 10: Regression Analysis on Linearity of IH 

Level Value No. 
X = Y = Peak  Peak Response 

ratio Conc.(mg/mL) Peak Area response 

50% 1 0.15032 3561685.7 23694812.0 1.00 

80% 2 0.24050 5671178.5 23580391.5 1.00 

100% 3 0.30063 7097547.4 23608912.5 1.00 

120% 4 0.36076 8561019.9 23730776.1 1.00 

150% 5 0.45095 10659158.0 23637379.2 1.00 

  

Mean 23650454.3 1.00 

SD 61694.1655 0.0026 

%RSD 0.3 0.3 

 

 

 

Figure 4: Calibration curve for IH 
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Figure 5: Peak Response for IH 

 

Table 11: Acceptance Criteria for linearity and range 

Parameters Acceptance criteria Results 

correlation coefficient, R
2
 > 0.999 1.000 

%RSD of peak response ≤ 2% 0.3% 

 

The linearity conforms to all acceptance criteria (Table 11). Therefore the range of 

analysis was 0.15032 mg/mL to 0.45095 mg/mL for IH. 
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4.2.4 Accuracy  

The accuracy of an analytical method is the extent to which test results generated by 

the method and the true value agree. Concentration of IH involved 50% 

concentration (0.150315 mg/mL), 100% concentration (0.300630 mg/mL) and 

150% concentration (0.450945 mg/mL). The data for accuracy was tabulated in 

Table 12 and the chromatograms have shown in Chromatogram 13 to 15 in 

Appendix 2. The Found concentration (Y) of IH in mg/mL was calculated based on 

the formula from linearity and range curve: 

  y = 23666991.4444x – 4889.7713 

                      In which; 

   y =Peak Area of IH 

                                    x =Concentration of IH (mg/mL) 

 

For this accuracy analysis, the peak area for IH was obtained from HPLC analysis. 

To calculate the found concentration of IH said Y obtains from the analysis. 

Therefore,  

  Y = (y – 4889.7713) /23666991.4444 

  In which;  

   Y = Found concentration in mg/mL 

                y = Peak area of IH 

 

The method has shown to be accurate for IH determination in Imipress Tablet 25 

mg and passed all the acceptance criteria (Table 13).     
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Table 12:  Recovery results for IH (of finished product form) 

Level 

(Expected content in 

mg/mL) 

Replicate Peak Area 

Y 

(Found concentration in 

mg/mL) 

%Recovery 

(100* Y/X) 

50% 1 3545303.4 0.1495929 99.52 

X = (mg/mL) 2 3574339.3 0.1508197 100.34 

0.150315 3 3565414.3 0.1504426 100.08 

  Mean 3561685.7 0.1502851 99.98 

  %RSD 0.4 0.4 0.4 

100% 1 7099833.1 0.2997822 99.72 

X = (mg/mL) 2 7093459.0 0.2995129 99.63 

0.300630 3 7099350 0.2997618 99.71 

  Mean 7097547.4 0.2996856 99.69 

  %RSD 0.1 0.1 0.1 

150% 1 10658558.2 0.4501488 99.82 

X = (mg/mL) 2 10692079.1 0.4515652 100.14 

0.450945 3 10626836.6 0.4488085 99.53 

  Mean 10659158.0 0.4501742 99.83 

  %RSD 0.3 0.3 0.3 

 

Average mean 99.83 

SD 0.290 

%RSD 0.3 

Confidence limit 0.22 
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Table 13: Acceptance Criteria for accuracy 

Parameters Acceptance criteria Results 

Overall mean accuracy 100% ±2% 99.83 

Overall % RSD ≤ 2% 0.3% 

Confidence limits at 95%  100% ± 2% 99.62% - 100.05% 

 

 

4.2.5 Precision (Repeatability and Intermediate Precision) 

Validation of tests for assay includes an investigation of precision. 
[2]

 The measures 

standard deviation can be obtained into repeatability and intermediate precision. 

Repeatability is obtained when the analysis is carried out in one laboratory by one 

operator using one piece of equipment over a relatively short time span. 

Repeatability was assessed using six determinations at 100% of the test 

concentration (0.3 mg/mL of IH). In Chromatogram 16 and 17 (Appendix 2) shows 

the chromatogram for Imipramine Hydrochloride Working Standard and IH in 

Imipress Tablet 25 mg, respectively. The acceptance criteria for precision depend 

very much on the type of analysis. While the compound analysis in pharmaceutical 

quality a control precision of better than 1% RSD is easily achieved. 
[3] 

Table 14, 15 

and 16 show the results for repeatability. Repeatability result also have been use to 

evaluate the intermediate precision for first analyst. 
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Table 14: IH Standard use in repeatability  

Imipramine Hydrochloride 

Weight of standard  30.71 mg 

Concentration of standard  0.3071 mg/mL 

Weight of 20 Imipress Tablets 25 mg  2798.36 mg 

Purity of IH  100.00% 

 

 

Table 15:  Repeatability for standard and sample injections 

No 

Retention 

Time 

Standard 

Area 

Standard 

Retention 

Time 

Sample 

Area 

Sample 

Weight of 

sample 

Assay %Assay 

1 7.85 7144443.2 7.78 6949239.2 168.35 24.82 99.26 

2 7.82 7147948.4 7.80 6990946.0 168.50 24.94 99.77 

3 7.80 7148073.9 7.81 6958568.6 168.54 24.82 99.28 

4 7.79 7148737.2 7.83 6992220.7 168.26 24.98 99.93 

5 7.78 7148939.2 7.84 7000723.6 168.25 25.01 100.06 

6 7.76 7146315.3 7.84 6997234.1 168.25 25.00 100.01 

Mean 7.80 7147409.5 7.82 6981488.7 168.36 24.93 99.72 

SD 0.032 1722.255 0.024 21853.497 0.131 0.090 0.358 

%RSD 0.4 0.02 0.3 0.3 0.1 0.4 0.4 
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Table 16: Acceptance Criteria for repeatability 

Parameters Acceptance criteria Results 

%RSD of standard retention time < 1% 0.4% 

%RSD for standard peak area < 2% 0.0% 

%RSD of sample result < 2% 0.4% 

Theoretical plate count > 2000 6676.8 

Tailing factor < 2 1.6 

 

Intermediate Precision is a term that has been define by ICH guidelines 
[2] 

as the 

long-term variability of the measurement process and is determined by comparing 

the results of a method run within a single laboratory over a number of weeks. A 

method’s intermediate precision may reflect discrepancies in results obtained by 

different analyst, from different instruments, with different column, different sample 

and standard preparation and different day.  

 

The objective of intermediate precision validation is to verify that in the 

same laboratory the method will provide the same results once the development 

phase is over. 
[3] 

The result for first analyst was obtained from repeatability testing. 

The result for second analyst was performed from a new sample and standard which 

prepared by different analyst (Table 17 and 18). In intermediate precision, the 

comparison of two analyst’s result, the acceptance criteria were tabulated in Table 

19 and 20, respectively. The chromatograms for first and second analyst have 

shown in Chromatogram 19 to 20. The difference in % between two analysts is 

within the acceptance criteria, hence the method is rugged. 
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Table 17: IH Standard use in intermediate precision (second analyst) 

Imipramine Hydrochloride 

Weight of standard  30.69 mg 

Concentration of standard  0.3069 mg/mL 

Weight of 20 CCM Tablets  2798.36 mg 

Purity of Imipramine Hydrochloride  100.00% 

 

 

Table 18:  Intermediate precision of standard and sample injections (second analyst) 

No 

Retention 

Time 

Standard 

Area 

Standard 

Retention 

Time 

Sample 

Area 

Sample 

Weight of 

sample 

Assay %Assay 

1 8.20 7164573.2 8.05 6846088.0 168.10 24.48 97.93 

2 8.19 7166265.2 8.05 6878338.3 168.50 24.54 98.16 

3 8.10 7170866.3 8.04 6901685.0 168.40 24.64 98.55 

4 8.07 7158157.1 8.03 6849749.3 168.20 24.48 97.93 

5 8.05 7194894.2 8.03 6932935.9 169.30 24.62 98.47 

6 8.05 7143083.2 8.04 6893588.3 168.50 24.59 98.38 

Mean 8.11 7166306.5 8.04 6883730.8 168.50 24.56 98.24 

SD 0.06 15528.41 0.01 30114.97 0.42 0.07 0.27 

%RSD 0.77 0.22 0.10 0.44 0.25 0.28 0.28 
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Table 19: Influence of two different analyst, different HPLC column, different 

HPLC instrument and different day on the analysis results 

              

 

 

 

 

 

 

 

 

 

Active 

Pharmaceutical 

Ingredient, API 

Event 

Assay of 6 

samples 

(%) 

Precision 

of sample 

assay 

(%RSD) 

Difference of 

mean value 

between analysts 

(%) 

Precision of 

standard 

injections 

(%RSD) 

Precision of 

standard 

retention time 

(%RSD) 

Imipramine 

Hydrochloride 

D1.A1.I1.C1 99.72 

 

0.4 

 

(+)1.48 

0.0 0.4 

D2.A2.I2.C2 98.24 

 

0.2 

 

0.2 0.7 

Acceptance criteria < 2% ± 2%. < 2% < 1% 
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Table 20: The difference in % between 2 analysts is within the acceptance criteria, hence 

the method is rugged. 

D1 Day 1 D2 Day 2 

A1 Analyst 1 [Radiatul Nadiah] A2 Analyst 2 [Paremala] 

C1 Column 1: 

Phenomenex Gemini, C18 

4.6 x 150mm, 5m 

S/N:56680-20 

C2 Column 1: 

Phenomenex Gemini, C18 

4.6 x 150mm, 5m 

S/N:56679-18 

I1 Instrument 1 

(Shimadzu Prominence) 

High Performance Liquid 

Chromatograph – Shimadzu 

Prominence, Shimadzu PDA 

Detector and LC Solutions 

Software for instrument 

control.( L20234915442)  

I2 Instrument 2 

(Shimadzu Prominence) 

High Performance Liquid 

Chromatograph – Shimadzu 

Prominence, Shimadzu PDA 

Detector and LC Solutions 

Software for instrument control. 

(L20154604090) 
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4.2.6 Robustness 

 The evaluation of robustness should be considered during the development phase 

and depends on the type of procedure under study. It should show the reliability of an 

analysis with respect to deliberate variations in method parameters. If measurements 

are susceptible to variations in analytical conditions, the analytical conditions should 

be suitably controlled or a precautionary statement should be included in the 

procedure. One consequence of the evaluation of robustness was to ensure that the 

validity of the analytical procedure is maintained whenever used. 
[2]

 ICH guidelines 

defined robustness as a measure of the method’s capability to remain unaffected by 

small, but deliberate variations in method parameters. 
[6]

 In this study, the parameters 

that have changed were flow rate, mobile phase composition and pH in mobile phase. 

The difference in % between the different in mobile phase composition, pH and flow 

rate is within the acceptance criteria, hence the method is robust. (Refer to 

Chromatogram 21 to 35). 

 

Table 21: IH standard and sample use in robustness (flow rate) 

Imipramine Hydrochloride 

Weight of standard  30.71 mg 

Concentration of standard  0.3071 mg/mL 

Weight of sample (mg)      168.35mg,168.50mg,168.54mg,168.26mg, 

168.25mg, 168.25mg 
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       Table 22: Results of robustness for IH: Change in flow rate 

 

 

Table 23: IH standard and sample use in robustness (mobile phase composition and pH) 

Imipramine Hydrochloride 

Weight of standard  30.23 mg 

Concentration of standard  0.3023 mg/mL 

Weight of sample (mg)      168.70mg,168.20mg,168.66mg,168.21mg, 

168.23mg, 16825mg 

 

 

 

Condition 

 

Tailing of 

standard 

solution 

Theoretical Plate 

Count of 6 

injections of 

standard solution  

Precision of 6 

injections of 

standard solution  

(%RSD) 

Mean 

assay of 6 

samples 

(%) 

Different 

in assay 

(%) 

A1 1.6 6676.8 0.02 99.72 - 

B 1.5 6186.9 0.07 99.82 (-)0.10 

C 1.6 7319.9 0.07 99.87 (-)0.15 

Acceptance 

criteria 

≤ 2 > 2000 ≤ 2.0 

Different in assay 

compare against 

Condition A1 

± 2% 
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Table 24: Results of robustness for IH: Change in mobile phase composition and pH 

 

 

 

 

 

 

 

 

 

 

Condition 

 

Tailing of 

standard 

solution 

Theoretical 

Plate Count of 6 

injections of 

standard 

solution  

Precision of 6 

injections of 

standard 

solution  

(%RSD) 

Mean assay 

of 6 

samples 

(%) 

Different in 

assay (%) 

A2 1.6 6251.9 0.28 100.66 - 

D 1.6 6287.9 0.46 100.63 (+)0.03 

E 1.6 6668.8 0.54 100.66 0.00 

F 1.6 6341.1 0.38 100.96 (-)0.30 

G 1.6 6312.1 0.45 100.43 (-)0.23 

Acceptance 

criteria 

≤ 2 > 2000 ≤ 2.0 

Different in assay compare 

against Condition A2 

± 2% 
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Table 25: Acceptance Criteria for Robustness 

Parameters Acceptance criteria Results 

System suitability for 6 conditions is met if: 

a) %RSD for standard peak area 

< 2% Complies 

b) Tailing factor of standard solution < 2 Complies 

c) Theoretical plate count > 2000 Complies 

Difference of mean values of assay results for 6 

conditions compare to original conditions  

not more than ± 2% Complies 

% RSD of standard retention time for 6 

conditions 

≤ 1% Complies  

% RSD of sample assay for 6 ≤ 2% Complies 

 

4.2.7 Solution Stability 

Solution stability of the drug substance or drug product after preparation should be 

evaluated according to the test method. Most laboratories utilized auto samplers 

with overnight runs and the sample will be in solution for hours in the laboratory 

environment before the test procedure is completed. This is concern especially for 

drugs that can undergo degradation by hydrolysis, photolysis or adhesion to 

glassware. The solution stability test has been performed in order to support the 

solution stability data of the sample under normal laboratory conditions. 
[6] 

Hence, 

the sample preparation had prepared at initial stage (Day 1) and the same sample 

has been re-injected after 24 hours- final stage (Day 2). However, the standard 

preparation for IH has been prepared freshly for each preparation. Table 26 and 27; 
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and Table 28 and 29 show the results for initial stage (Day 1) and final stage (day 

2), respectively. 

 

Table 26: IH Standard use in solution stability (Day 1) 

Imipramine Hydrochloride 

Weight of standard  30.71 mg 

Concentration of standard  0.3071 mg/mL 

Weight of 20 Imipess Tablets 25 mg  2798.36 mg 

Purity of IH  100.00% 

 

Table 27:  Results for solution stability (Day 1) 

No 

Retention 

Time 

Standard 

(Day 1) 

Area 

Standard 

Retention 

Time 

Sample 

(Day 1) 

Area 

Sample 

W Assay %Assay 

1 7.85 7144443.2 7.78 6949239.2 168.35 24.82 99.26 

2 7.82 7147948.4 7.80 6990946.0 168.50 24.94 99.77 

3 7.80 7148073.9 7.81 6958568.6 168.54 24.82 99.28 

4 7.79 7148737.2 7.83 6992220.7 168.26 24.98 99.93 

5 7.78 7148939.2 7.84 7000723.6 168.25 25.01 100.06 

6 7.76 7146315.3 7.84 6997234.1 168.25 25.00 100.01 

Mean 7.80 7147409.5 7.82 6981488.7 168.36 24.93 99.72 

SD 0.032 1722.255 0.024 21853.497 0.131 0.090 0.358 

%RSD 0.4 0.02 0.3 0.3 0.1 0.4 0.4 
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Table 28: IH Standard use in solution stability (Day 2) 

  Imipramine Hydrochloride 

Weight of standard  30.86 mg 

Concentration of standard  0.3086 mg/mL 

Weight of 20 Imipress Tablets 25 mg  2798.36 mg 

Purity of IH  100.00% 

 

 

Table 29:  Results for solution stability (Day 2) 

No 

Retention 

Time 

Standard 

(Day 2) 

Area 

Standard 

Retention 

Time 

Sample 

(Day 1) 

Area 

Sample 

W Assay %Assay 

1 8.11 7134729.5 8.70 7106053.5 168.35 25.25 100.98 

2 8.11 7282552.2 8.24 7087123.4 168.50 25.16 100.62 

3 8.12 7227620.4 8.20 7219952.4 168.54 25.62 102.49 

4 8.15 7230680.7 8.19 7069441.1 168.26 25.13 100.52 

5 8.16 7220042.4 8.15 7074559.1 168.25 25.15 100.60 

6 8.16 7220295.0 8.12 7075949.4 168.25 25.15 100.62 

Mean 8.13 7219320.0 8.27 7105513.1 168.36 25.24 100.97 

SD 0.022 43499.614 0.197 52548.673 0.131 0.190 0.760 

%RSD 0.3 0.6 2.4 0.7 0.1 0.8 0.8 
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Table 30: Different in sample value 

Active Day 1 Day 2 % Difference 

IH 99.72 100.97 (-) 1.2% 

 

 Difference of peak response   = 7219320.0 × 100% 

                 7147409.5 

       = 101.0% 

 

Table 31: Difference of peak response  

Active Initial  24 hours % Difference 

IH 7219320.0 7147591.9 101.0 

        

Table 32: Acceptance Criteria for Solution Stability 

Parameters Acceptance criteria Results 

Difference in sample value with Day 1 ≤ 2% (-)1.2% 

Difference of peak response for freshly 

prepared sample solution and sample 

solution kept for specific hours 

98% to 102%. 101.0% 

 

The stability of the solution conforms to the acceptance criteria. The solution is 

stable up to 24 hours storage in HPLC auto sampler at room temperature. 
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CHAPTER 5 

 

CONCLUSION 

 

The analytical method developed and validated for assay by HPLC is suitable for 

the accurate and precise determination of Imipramine Hydrochloride content in Imipress 

Tablet 2 mg.  This method has been shown to be linear, accurate, precise, rugged and robust. 

The HPLC method is therefore suitable for use as a stability indicating method for 

determination of Imipramine Hydrochloride content in Imipress Tablet 2 mg. 
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     Appendix 1 

 

 Operating Procedure for Analytical Method Validation  

by HPLC and UPLC (Assay) 

 

1.0 Purpose  

1.1 To define the procedure to perform the analytical method validation by 

HPLC and UPLC. 

 

2.0 Scope 

2.1 This SOP covers the validation for assay analysis in pharmaceutical products 

by HPLC and UPLC method.  

2.2 The method could be compendial method, non-compendial method or in-

house method.  

 

3.0 Responsibility 

3.1.1 Validation team 

 

4.0 Frequency 

4.1 Upon development of new or upon modification of existing HPLC and 

UPLC methods for assay analysis 
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5.0 Procedures   

5.1 The typical validation characteristics considered for Assay Analysis are:  

i. Specificity 

ii. Linearity and Range 

iii. Accuracy 

iv. Repeatability 

v. Intermediate Precision 

vi. Robustness (optional) 

vii. Solution stability (optional) 

viii. System suitability 

ix. Limit of Quantification (LOQ) 

x. Limit of Detection (LOD) 

 

5.2 Assay Method Validation 

5.2.1 Specificity 

Specificity is the ability to measure accurately and specifically the analyte 

of interest in the presence of other components that may be expected to be 

present in the sample matrix. Typically these might include impurities, 

degradants, matrix, etc.  

 

5.2.1.1 Specificity determination (Placebo analysis): 

a) The analysis of a placebo (sample matrix without the analyte) 

is analyzed and the resulting system response is examined for 
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the presence of response which interferes or overlap with that 

of analyte of interest. 

b) In this case, prepare the placebo as in the manufacture 

formula.  

c) Dilute the placebo as in the Assay preparation and inject it 

into the chromatogram.  

 

 5.2.1.2 Specificity determination (Force degradation): 

a)  For full validation, force degradation study will be carried out 

for placebo, standard and sample. For verification of 

compendia method, force degradation study will be carried 

out for sample only. 

b)  The force degradation study is complete when the standard 

and sample are degraded at least 20% by one of the following 

degradation method ie: acid hydrolysis, basic hydrolysis, 

aqueous degradation, oxidation degradation, photolysis or 

thermolysis.  

 

5.2.1.3 Specificity determination (Peak purity assessment using a 

diode array detector): 

a)  The peak purity test is to show that the analyte 

chromatographic peak is not attributable to more than one 

component. 
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5.2.2 Linearity and Range 

a)   The linearity of an analytical procedure is its ability to obtain test 

results which are directly proportional to the concentration of analyte 

in the sample.  

b)    The range of an analytical procedure is the interval between the 

upper and lower concentration of analyte in the sample for which it 

has been demonstrated that the analytical procedure has a suitable 

level of precision, accuracy and linearity. 

c)    Linearity and Range determination: 

i.   Prepare minimum five (5) standard solutions with 

concentration from at least 50% to 150% of the working 

concentration. The targeted concentration of the analyte as 

described in the method must fall between this range 

ii.   If assay and impurity are performed together as one test and 

only a 100% standard is used,   linearity should cover the 

range from the reporting level of the impurities (LOQ) to 

120% of the assay specification (reference to ICH Q2 R1 

guidelines). 

iii.  For each of the minimum five (5) concentrations prepared, 

inject three (3) times for each of the solutions onto HPLC / 

UPLC system. 

iv.   The result of the mean peak area obtained for each solution is 

plotted against its corresponding theoretical concentration, 
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and a linear regression analysis is performed on the minimum 

five (5) coordinates. 

 

5.2.3 Accuracy 

a)   The accuracy is the measure of exactness of an analytical method, or 

the closeness agreement between the measured value and the value 

that is accepted either as a conventional, true value or an accepted 

reference value. 

    b)   Accuracy determination: 

1.  There are minimum three (3) methods to assess accuracy: 

i. Prepare a known standard stock solution and spike into 

the placebo at 3 levels of analyte concentrations, ie: 80%, 

100% and 120%. The spiked solutions are analyzed for 

the content of analyte against a Standard calibration curve 

obtained from Linearity and Range. 

ii. Weigh and add the known amount of analyte into placebo 

at 3 levels of analyte concentrations, ie: 80%, 100% and 

120%. The weighed analytes is analyzed against a 

Standard calibration curve obtained from Linearity and 

Range. 

iii. For standard additional method, spike in the known 

amount of analyte into finished product at 3 levels of 

analyte concentrations, ie: 80%, 100% and 120%. The 

accuracy of spiked analyte is calculated based on the 
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found concentration of analyte against theoretical 

concentration of analyte. 

 

2.   The 3 levels of analyte concentrations, ie. 80%, 100% and 

120% can be changed wherever necessary, but it should be at 

least cover 80% to 120% of the working concentration of 

analyte. 

 

3.   If the method to assess the accuracy of the analytical method is 

different  from the three (3) methods as stated in Section 

5.3.3.1(1), this method must be described  clearly in the 

individual protocol before execution. 

 

4.   For method 5.3.3.1(1a) and 5.3.3.1(1b), the amount of analyte 

recovered is calculated from the peak response of each test 

solution obtained: 

                     % accuracy =    (Peak response – intercept) x 100% 

                                    ___   Slope   

                                               Theoretical concentration 
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5.    For method 5.3.3.1(1c), the amount of analyte recovered is 

calculated based on the formula below: 

                        % accuracy = W2 x 100% 

                                                 W1 

   which,   W2 = Found concentration of analyte 

                                             W1 = Theoretical concentration of analyte 

 

  5.2.4 Precision 

a)  The precision of an analytical procedure expresses the closeness of 

agreement (degree of scatter)  between a series of measurements 

obtained from multiple sampling of the same homogeneous sample 

under the prescribed condition. 

b)  Two (2) levels : Repeatability and Intermediate precision 

 

    5.2.4.1 Repeatability: 

  a) Repeatability expresses the precision under the same operating 

conditions over a short interval of time. Repeatability is also 

termed intra-assay precision. 

      b) Repeatability determination: 

i)  Determine the precision of the method by preparing six (6) 

samples from the same lot of product. Prepare test solutions 

according to the method under validation. 
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ii) Calculate the %RSD of the six results for each analyte with 

respect to retention time and peak responses. 

 

5.2.4.2 Intermediate precision  

a) Intermediate precision refers to the results from within-lab 

variations due to random events within laboratories’ variations. 

This is to test on ruggedness for the same homogenous lot of 

sample (finish product or simulated product) by two different 

analysts which the testing is carried out on: 

 i)   Different days  

 ii)  Different standard preparation  

 iii) Different sample preparation  

 iv) Different instrument/column  

b)  Intermediate precision determination: 

i)  One (1) standard solution and six (6) sample solutions are 

prepared   by analyst 1 on the first day and analyzed according 

to the method under validation. 

ii) One (1) standard solution and six (6) sample solutions are 

prepared by analyst two on different day using the 

same/different instrument according to the method under 

validation. 
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 5.2.5 Robustness (Optional) 

a)   The robustness of an analytical procedure is a measure of its capacity 

to remain unaffected by small, but deliberate, variations in method 

parameters and provides an indication of its reliability during normal 

usage. It should be evaluated during the development phase. 

b)    Perform at least two (2) variations such as different brand of column, 

temperature, pH of buffer, ratio of mobile phase, flow rate, gradient 

curve etc. 

c)   Robustness determination: 

i)  Prepare one (1) standard solution and six (6) replicates of sample 

solutions under the condition as described in the assay method. 

 

  5.2.6   Solution Stability (Optional) 

a) The solution stability test is to check the stability of standard and 

sample solutions for specific hours at room temperature/fridge. 

b) All the test solutions from the Precision test are injected after being 

kept for specific hours at room temperature/fridge and calculated 

against freshly prepared standard. 

c) A new standard solution is prepared and compared to the standard    

solution that kept for specific hours at room temperature/fridge. 

d) If the solutions are not stable for specific hours, then the time period 

for which solutions are stable should be determined and the test 

procedure should contain a statement to this effect. 
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e) Solution stability study is not listed as the compulsory test parameters 

for analytical test method validation. However, it should be considered 

at an appropriate stage in the development of the analytical procedure. 

 

5.2.7 System Suitability 

   a)  Performance of a system is checked by performing system suitability 

tests that are designed to evaluate the performance of the entire system. 

b)   The system suitability tests are established during method development 

and validation phases to check on the performance of the system. 

c)   The performance is evaluated in terms of the following parameters: 

i)  System precision: 

Six replicates of the working concentration (100%) are injected 

into the chromatograph. 

ii)  Theoretical Plate Count (N): 

The efficiency is defined in terms of the number of theoretical 

plates (N) per column and is calculated based on equation below: 

N = 5.54 (VR
2
 / Wh2) 

   where, 

VR    = The distance along the baseline between the 

point of injection and a perpendicular dropped 

from the maximum of the peak of interest. 
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Wh   =  The width of the peak of interest at half peak 

height, measured in the same units as VR. 

iii)  Tailing factor 

The accuracy of quantitation decreases with increase in peak 

tailing because of the difficulties encountered by the integrator in 

determining where / when the peak ends and hence the 

calculation of the area under the peak.  The symmetry factor is an 

indicator of peak skewness and is calculated using the equation. 

f  =  Wx / 2d 

         where, 

        Wx  =   Peak width at 5% of peak height. 

D                =  Distance between the perpendicular dropped 

from the peak maximum and the leading edge 

of the peak at 5% of the peak height. 

iv) Capacity factor (k’) (if applicable): 

The capacity factor is a measure of where the peak of interest is 

located with respect to the void volume, ie: the elution time of 

the non-retained components (0.01% Uracil in diluents) or 

column void volume.  It is calculated using the equation: 

      TR - TO 

k’ =  ---------- 

      TO 
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where, 

       TR  =  Elution time of the analyte. 

       TO                =  Elution time of the void volume or non-

retained components. 

Normally for TO, the retention time of a 0.01% of Uracil in the 

diluent, is used. 

 v)  Resolution (if applicable): 

The resolution is to measure the quality of separations of the 

adjacent peaks.  

     

6.0 Acceptance Criteria 

 Analytical 

Test Method 

Analytical 

Performance 

Characteristics 

Acceptance criteria 

Assay Specificity 

(Placebo 

Analysis) 

No peak/s greater than noise at the +5% retention 

time window of the principal analyte peak. 

 

 

Specificity (Force 

degradation) 

 

 

i. Analyte peak must be well resolved from the 

other peaks (Resolution > 1.5 unless otherwise 

specified in the individual monograph). 
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Specificity (Peak 

purity assessment 

using a diode 

array detector) 

i. The peak purity index as obtained is greater 

than 0.95. 

 

Linearity and 

Range 

 

i. r2 
> 0.999 

ii. %RSD of peak response < 2% 

iii. Magnitude of intercept against 100% working 

standard ± 2% 

Accuracy i. Overall mean accuracy within 100% ± 2% for 

ethical finished products and 100% ± 5% for 

OTC finished products or unless otherwise 

specified in the individual protocol. 

ii. Confidence limit at 95%, μ is 100% + 2% for 

ethical finished product and 100% ± 5% for 

OTC finished products or unless otherwise 

specified in the individual protocol. 

iii. % RSD for the measurement precision ≤ 2% 

for ethical finished products and ≤ 5% for OTC 

finished products or unless otherwise specified 

in the individual protocol 

Precision: 

Repeatability 

i. % RSD of the retention time for standard < 1% 

ii. %RSD of the standard peak area < 1% unless 
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otherwise specified in the individual 

monograph. 

iii. %RSD of the samples results < 2% for ethical 

finished products and < 5% for OTC finished 

products or unless otherwise specified in the 

individual protocol. 

Precision: 

Intermediate 

precision 

i. % RSD of the retention time for standard < 1% 

ii. %RSD of the standard peak area < 1% unless 

otherwise specified in the individual 

monograph. 

iii. %RSD of sample results < 2% for ethical 

finished products and < 5% for OTC finished 

products or unless otherwise specified in the 

individual protocol. 

iv. %RSD of combined results < 2% for ethical 

finished product and < 5% for OTC finished 

products or unless otherwise specified in the 

individual protocol. 

v. Difference of mean value of results between 

analysts within ±2% for ethical finished 

products and ± 5% for OTC finished products 

or unless otherwise specified in the individual 

protocol. 
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Robustness i. % RSD of the retention time for standard < 1% 

ii. %RSD of sample assay < 2% 

iii. Difference in assay results not more than ± 2%. 

iv. Achieve the system suitability requirements. 

Solution stability i. Difference in assay results ± 2% for ethical 

finished products and ± 5% for OTC finished 

products 

ii. Difference in peak response of freshly prepared 

standard solution and standard solution kept for 

specific hours ± 1% or unless otherwise 

specified in the individual protocol. 

System suitability 

 a) System 

precision 

i. %RSD of standard retention time < 1%. 

ii. %RSD of standard peak area < 1%. 

System suitability 

b) Theoretical 

Plate Count 

(N) 

The column efficiency is generally recommended 

to be more than 2000 unless otherwise specified in 

the individual monograph. 

 

System suitability 

c) Tailing factor 

i. Tailing factor is generally ≤ 2 unless otherwise 

specified in the individual protocol. 

ii. Tailing factor is 0.8 to 1.5 for BP monograph 

method 
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System suitability 

d) Capacity factor 

k’ > 2 unless otherwise specified in the individual 

monograph. 

System suitability 

e) Resolution 

 

Resolution > 2 unless otherwise specified in the 

individual monograph. 
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    Appendix 2 

 

Operating Procedure for the Shimadzu Prominence High Performance Liquid 

Chromatography 

 

1. Purpose 

To guide the user to operate the instrument accordingly 

 

2. Scope 

The Work Instruction applies to the description and usage of: 

a. The degasser; Model: Shimadzu DGU-20A3 Degasser 

b. The pump; Model: Shimadzu LC-20AT Prominence LC 

c. The detector; Model: Shimadzu SPD-20A Prominence uv/vis Detector 

d. The auto sampler; Model: Shimadzu SIL-20A Prominence 

e. Column oven; Model Shimadzu CTO – 10AS VP 

f. The computer; Model: DELL 

 

3. Responsibility 

3.1 Lab Technician 

 - Responsible to strictly adhere to this work instruction. 

3.2 Lab supervisor/ Executive 

 - Responsible to ensure strict adherence to this work instruction. 
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4. Procedures 

4.1 Turn ON the power of the pump A, detector, auto sampler, oven, pump B and 

computer. 

4.2 Logging into LC solution. 

4.2.1 Double-click on Analysis 1 (Instrument 1) from main menu. 

4.3 Setting up run parameters. 

 4.3.1 Select New or Open from File > New Method File / Open Method File. 

 4.3.2 Select Method > Instrument Parameters. 

 First select the Advanced > Pump, then select the Isocratic Flow / 

Binary Gradient mode. 

 Set the flow rate, upper and lower pressure limit for pump A and pump 

B pressure limit at 40.0 MPa. 

 Set the temperature required and the T. Max. at 85
o
C. 

 Set the time expected for the actual analysis in LC Stop Time at Data 

acquisition text box > Apply to All acquisition time. 

 When using the isocratic flow enter a stop time for the time program 

under the Time Program table and if using the Binary gradient set the 

time program under the Time program table. 

 For a Detector A, select the D2 lamp ratio and designate the required 

wavelength. 

 Click on the Download button to send the setting to the system and save 

the method. 

 Press the Instrument On/Off button on the Direct Control toolbar to 

activate the system.   
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 Open the drain valve and press the Purge sampler button to begin the 

purge cycle of the auto sampler syringe; wait until finished. 

 Close the drain valve and press the pump On/Off button. 

 From the File menu, select Personal name folder > Method file > 

Product Tested and save under the created method and save the file. 

 When the signal stabilizes, press Zero Detector A button in the Direct 

Control toolbar to the zero signal. Wait for the baseline to stabilize. 

 

4.4 Sample Injection: 

 4.4.1 Single sample injection 

 Click the Single Start button. 

 Enter the settings required for analysis and press OK. 

 Save the Method file and Data File under the same folder. 

 Once the actual retention time get set the LC Stop Time > Apply to All 

acquisition time. 

 

 4.4.2 Batch processing injection 

 Open the new Batch Processing table 

 From the File menu, click the New Batch File. 

 Click the Wizard button and enter the start vial and injection volume. 

 Press Next and select the standard location in the sequence. 

 Press Next again and enter the sample name and sample ID. 

 To automatically increment the Data file name, use parentheses around 

the starting number, i.e. Sample 001.lcd. 
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 Click the Data File and select in the same folder with Method file. 

 Change the number of standard sample vial per level and repetition 

run. 

 Select the Print report and change the Report format file in the same 

folder with Method file and Data file. 

 Click Next and enter the Sample name and Sample ID. 

 Select the Data File in the same folder with Method File and Data file. 

 Change the number of unknown sample vials in each group and 

Repetition per Run. 

 Select the Print report and change the Report format file in the same 

folder with Method file and Data file. 

 Click Next > Finish. 

 Ensure all the information appears on the Batch table. 

 Once the Batch processing is complete, click  File > Save Batch File As 

>  person name > Method File > Product tested > File Name > Save.  

( * Save the Batch Files As in the same folder with method File and Data 

File ) 

 Click Batch Start > Yes. 

 

4.5 Print a Report 

 4.5.1 Data Report  

 Click LC Postrun Analysis at the LC Solution menu. 

 Double click File > Open > Data file and double click the required data 

to open the Chromatogram. 
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 Click Wizard and set the minimum area/height and click Next > select 

the peak > Next > Next (change the name peak) > Finish. 

 Click View button on the Compound table view. 

 Click Data report. 

 Open any report format from other file and drag it to the chromatogram. 

 Adjust the User Information; 

a. Double click at user information. 

b. Click at Sample information > default and change the aquired by ( 

user name) > apply and OK. 

 Adjust the chromatogram scale. 

a. Double click at chromatogram. 

b. Change the type of chromatogram, range for X schale (time) and 

Left Y schale (Inten.) 

c. Change to User Defined in Left Y schale (Inten.) and the limitation 

from –ve integer – +ve integer. 

d. Click OK. 

 Adjust the other Item ( eg. Theoretical Plate, Tailing Factor, 

Resolution, etc.) 

a. Double click at chromatogram table. 

b. Insert the column by click at any table. 

c. Choose the item need and click Apply > OK. 

 Once the actual Data Report get, save into File > Save Report Format 

file As > Method File > Product tested > Report Format > Save. 
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 Then click Return > Apply to the method > Method File > product 

tested > Save. 

 Finally click File > Save data > Yes > OK. 

 

4.6 Cleaning of the Injection 

a. After all the analyses have been completed, remove the vials from the rack. 

b. Press the rinse sampler button on the Direct Control toolbar to begin the rinse 

cycle of the auto sampler syringe. 

 

4.7 Cleaning the HPLC 

a. Change the filtered water each time using of HPLC 

b. Change 50% Acetonitrile: Water and 100% Acetonitrile when the volume of 

this solution is less than 500ml. 

c. Remove all the Mobile Phase Bottle, flushing and storing reagent bottle from 

HPLC after using. 

 

5 Maintenance 

External cleaning of the Instrument: 

a. Dust the external surface of the instrument and the surrounding area where the 

instrument is placed. 

b. The surrounding area is also cleaned with wet cloth. 

c.    The external cleaning are done once in two weeks and monitored by Validation 

Chemists. 
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Appendix 3 

 

Chromatogram 1: Chromatogram of Imipramine Hydrochloride Working Standard 
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Chromatogram 2: Chromatogram of standard  

 
 

Chromatogram 3: Chromatogram of placebo 
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Chromatogram 4: Chromatogram of blank (diluent) versus sample solution in diluent. 
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Chromatogram 5: Chromatogram of sample solution in 3M HCl / 70ºC/ 2 hours 
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Chromatogram 6: Chromatogram of sample solution in 3M NaOH / 70ºC/ 2 hours 
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Chromatogram 7: Chromatogram of sample solution in 3% H2O2 / 70ºC/ 2 hours 

 
 

 

 



79 

 

Figure 6: Peak purity of Sample in diluent. 

 
 

Figure 7: Peak purity of Sample in 3M HCl / 70ºC/ 2 hours 
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Figure 8: Peak purity of Sample in 3M NaOH / 70ºC/ 2 hours 

 
 

Figure 9: Peak purity of Sample in 3% H2O2 / 70ºC/ 2 hours 
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Chromatogram 8: Chromatogram for at 50% of target concentration. 
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Chromatogram 9: Chromatogram for at 80% of target concentration. 

 
 

 

 



83 

 

Chromatogram 10: Chromatogram for at 100% of target concentration. 
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Chromatogram 11: Chromatogram for at 120% of target concentration. 
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Chromatogram 12: Chromatogram for at 150% of target concentration. 
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Chromatogram 13: Chromatogram for 3 samples at 50% of target concentration. 
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Chromatogram 14:  Chromatogram for 3 samples at 100% of the target concentration  
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Chromatogram 15: Chromatogram for 3 samples at 150% of the target concentration. 
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Chromatogram 16: Chromatogram of standard 
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Chromatogram 17: Chromatogram of samples 
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Chromatogram 18: Day 1, Analyst 1, Instrument 1 and Column 1_Chromatogram of 6 

Standard    Injections. 
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Chromatogram 19: Day 1, Analyst 1, Instrument 1 and Column 1_Chromatogram of 6 

replicates sample    Injections. 
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Chromatogram 20: Day 2, Analyst 2, Instrument 2 and Column 2_Chromatogram of 6 

Standard    Injections. 
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Chromatogram 20: Day 2, Analyst 2, Instrument 2 and Column 2_Chromatogram of 6 

Replicates Sample Injection. 
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Chromatogram 21: Chromatogram of 6 Injections of Standard at Condition A1 
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Chromatogram 22: Chromatogram of 6 Samples Injection at Condition A1 
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Chromatogram 23: Chromatogram of 6 Injections of Standard at Condition B 
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Chromatogram 24: Chromatogram of 6 Samples Injection at Condition B 
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Chromatogram 25: Chromatogram of 6 Injections of Standard at Condition C 
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Chromatogram 26: Chromatogram of 6 Samples Injection at Condition C 
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Chromatogram 27: Chromatogram of 6 Injections of Standard at Condition A2 
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Chromatogram 28: Chromatogram of 6 Samples Injection at Condition A2 
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Chromatogram 29: Chromatogram of 6 Injections of Standard at Condition D 
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Chromatogram 30: Chromatogram of 6 Samples Injection at Condition D 
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Chromatogram 31: Chromatogram of 6 Injections of Standard at Condition E 
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Chromatogram 32: Chromatogram of 6 Samples Injection at Condition E 
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Chromatogram 33: Chromatogram of 6 Injections of Standard at Condition F 
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Chromatogram 34: Chromatogram of 6 Samples Injection at Condition F 
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Chromatogram 35: Chromatogram of 6 Injections of Standard at Condition G 
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Chromatogram 36: Chromatogram of 6 Samples Injection at Condition G 
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Chromatogram 37: Chromatogram of 6 injections of standard at initial 

 
 

 

 



112 

 

Chromatogram 38: Chromatogram of 6 samples injection at initial 
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Chromatogram 39: Chromatogram of 6 injections of fresh standard  
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Chromatogram 40: Chromatogram of 6 samples injection at 24 hours 
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